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DRV84xxEVM GUI User's Guide

This document is provided with the DRV84xx evaluation module (EVM) as a supplement to DRV84xx
Stepper Motor Driver datasheet. This user's guide details on how to use the DRV84xx EVM GUI
application.
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1 Overview
The DRV84xx EVM is a platform to support prototyping and evaluation for the DRV84xx, a medium-
voltage dual H-bridge driver for stepper driving applications. The DRV84xx drives a single bipolar stepper
with microstep settings ranging from full-stepping to 1/256 resolution with internally-regulated microstep
levels. It provides a variety of programmable decay settings.

The EVM uses an MSP430™ microcontroller and a USB interface chip to manage communication from
the GUI software application installed on a PC computer with Windows®. The GUI sends serial
commands to the MSP430 to control the device signals, monitor faults, read and write SPI registers, and
drive a stepper motor by issuing the step commands at the desired rate. This document describes the
software and tools used to evaluate DRV84xx device for stepper motor driving on the DRV84xx EVM.

2 Hardware and Software Setup
The hardware (HW) and software (SW) tools that follow are required for the evaluation of DRV84xx:
• DRV84xx EVM
• Stepper motor
• Voltage supply from 4.5 to 48 V

This document only describes the installation and usage of the DRV84xx EVM GUI. For additional details
on hardware connections refer to the DRV84xx EVM User's Guide .
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3 GUI Application

3.1 Installation
Installation (For Desktop Version Only)
• Download the installable DRV84xx_1.0.0_installer_win.zip file.
• Extract the zip.
• Double click on the installer to install the GUI Application. During first time installation, the installer

prompts for installation of Cloud Agent. Please Install it. During the installation, customer company's
firewall may block "download from website” option for the GUI composer runtime installation, please
download GUI runtime v7.4.1 from this link: https://software-dl.ti.com/ccs/non-
esd/gui_composer/runtime/gcruntime-7.4.1-windows-installer.exe and save it to your local harddrive.
And then, use "Install from File" option to install the GUI composer runtime.

3.2 Getting Started with DRV84xx EVM GUI
The DRV84xx EVM GUI and DRV84xx EVM allows the user to configure various settings required for
stepper motor driving. The DRV84xx EVM GUI lets the user adjust the motor speed, control the direction,
control the step movement, configure various device settings, and monitor the device status.

Perform the following steps to begin using the GUI:
• Connect the stepper motor to the EVM.
• Plug in the micro-USB cable to the PC.
• Enable the motor power supply. For additional details on hardware connections refer to the DRV84xx

EVM User's Guide

Click on DRV84xx EVM GUI shortcut either on the desktop or from the start menu to run the GUI
application.

3.3 Use the DRV84xx EVM GUI
After open the DRV84xx GUI, the GUI landing page shown in Figure 1

http://www.ti.com
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Figure 1. DRV84xx EVM GUI (Landing Page)

After click the DRV84xxP device from the GUI landing page, the DRV84xxP GUI home page shown in
Figure 2

The application will try to establish communication with the device connected. A message showing
‘Connected to Cloud Agent. Connecting to target…’ will be displayed in the hardware connection status
pane at the bottom of the screen. If the connection is successful, ‘COMxx:9600 Connected to Target’
message appears as shown in Figure 3 below

http://www.ti.com
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Figure 2. DRV84xx EVM GUI (Home Page)

Figure 3. DRV84xx EVM GUI (Device Connection Pane)

If the GUI fails to connect to the EVM, the hardware connection status pane will show the message
‘Hardware Not Connected’.

If the GUI is opened without connecting the EVM, the hardware connection status pane will show ‘Error:
no serial ports found’.

If there are more than one DRV84xx EVM boards connected, the first matching device will be connected
automatically. In order to switch to another EVM:
1. Click Options -> Serial Port. A serial port configuration popup is displayed as shown below in Figure 4.
2. Choose the appropriate port and baud rate.
3. Click OK

http://www.ti.com
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Figure 4. Serial Port Configuration

Once the correct device is connected, the home page will show a message ‘Device Connected’ with a
green check mark as shown in Figure 2

Click on the ‘Stepper Motor’ button to open the stepper control page.

3.3.1 Stepper Control Page
This page (shown in Figure 5) includes various controls to sleep/wake the driver, ocp latched settings and
control the stepper motor by configuring various parameters such as full scale current, step mode,
direction and so forth. Hovering over the (?) icon to the right of a control displays a brief description about
the control.

http://www.ti.com
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Figure 5. DRV84xx EVM GUI (Stepper Motor Control Page)

3.3.1.1 Stepper Control Modes
The GUI allows the user to control the stepper motion profile in two modes – Speed Mode and Step Mode.
To toggle between the modes, use the toggle button at the top of the screen.

3.3.1.1.1 Speed Mode
Speed Mode allows the user to spin the stepper motor continuously at a desired speed. The user
configures the starting speed, stopping speed, acceleration rate, and target speed. Stepper controls are
enabled only when ‘Motor Driver' control is enabled. ‘Start Steps’ button is enabled only when ‘Driver
Outputs' control is enabled for example, ENABLE pin is set to high. When the ‘Start Steps’ button is
clicked, the motor begins spinning at the starting speed and accelerates to the target speed according to
the configured acceleration rate. The acceleration profile in the microcontroller firmware accepts the
starting-speed PPS signal and target-speed PPS signal as a clock cycle number.

When the ‘Start steps’ button is clicked, the PWM timer generates steps at a rate specified by the 'Starting
Speed' PPS parameter. When ‘Stop Steps’ is clicked, the motor starts decelerating at the ‘Acceleration
Rate’ configured to reach the stopping speed and eventually stop. The configuration is visualized by the
embedded graph shown on the GUI screen.

When accelerating or decelerating, the PPS signal is adjusted every 32 ms based on the integer value of
PPSPS / 32 ms. Acceleration rates must be between 1 and 65,535 PPSPS. The step rate increases by
the calculated value until the target speed is reached.

The starting speed must be less than or equal to the target speed. If the starting speed and target speed
are equal, the EVM firmware will not perform an acceleration routine. The stopping speed must also be
less than or equal to the target speed. The target speed is limited to a range between 1 and 65,535 PPS.

http://www.ti.com
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The 'Start Steps' command computes how frequently automatic speed updates are issued and a second
timer is used to change the speed according to the programmed acceleration rate profile. Once clicked,
the motor will begin spinning according to the parameters set in the GUI.

When the target speed PPS value is reached, the acceleration profile ends and the motor continues
running until the 'Stop Steps' button is clicked. When the stepper is commanded to stop, the controller
performs the same actions as it did while accelerating, but in reverse order to decelerate until the stop
speed PPS value is reached, in which case the motor fully stops.

Figure 6 shows the acceleration profile and the role each parameter plays during speed computation.

Figure 6. Controls Available for Speed Mode

3.3.1.1.2 Step Mode
Step Mode allows the user to move the stepper motor a configured number of steps. Stepper controls are
enabled only when ‘Motor Driver' control is enabled. ‘Start Steps’ button is enabled only when ‘Driver
Outputs' control is enabled for example, ENABLE pin is set to high. When the ‘Start Steps’ button is
clicked, the motor starts spinning at the starting speed and accelerates at the rate configured to reach until
the number of steps is reached after which it stops.

The acceleration and deceleration profiles work similarly as before, except when the deceleration routine
starts and when the motor stops are a function of the 'Steps to Stop' and deceleration rate parameters.

The configuration can be visualized in the graph embedded in the GUI. If the "Reciprocate" button is
enabled, the stepper will travel the set number of steps, then reverse direction. It will do this continuously
until 'Stop Steps' is clicked. Figure 7 shows the controls available in Step Mode.

Figure 7. Controls Available for Step Mode

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLOU517A
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The parameters from 'Speed Mode' are reused as well, and they operate the same as described in
Section 3.3.1.1.1. Two new parameters have been added to properly control the limited number of steps
actuation. These parameters are described as follows:

Number of Steps—This parameter is the number of steps that the controller will issue.

Steps to Stop—The controller is continuously monitoring the step being issued and when the current step
is equal to the 'Steps to Stop' parameter, a deceleration profile is issued. If the value of the 'Steps
to Stop' parameter is larger than the number of steps, then the motor stops abruptly and without
undergoing a deceleration profile.

When a deceleration profile is issued, the controller decreases the speed until reaching the value of the
'Stopping Speed' parameter. If the 'Number of Steps' parameter is met before the deceleration profile is
complete, then the motor stops at the current speed. If the stopping speed is met before all the number of
steps is issued, then the motor rotates at the stop speed value until all the steps are executed.

Ideally, the system should resemble the case in which the controller executes all the commanded steps at
a speed as close as possible to the stop speed. In the event this is not possible because of the particular
parameters that were selected, stopping the motor at a speed very close to the 'Stopping Speed'
parameter is often good enough to ensure good motion quality and application performance.

Figure 8. Stop Conditions

3.3.2 Decay Mode
Decay refers to how the driving currents recirculate in H-bridge FETs during the off time. The user
configures the decay mode using the GUI

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLOU517A
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Figure 9. DRV84xx EVM GUI (Decay Mode)

Decay mode and appropriate TOFF values can be configured in this section. The configurations can be
visualized in the graph shown. For information about the different decay modes, refer to the DRV84xx
Stepper Motor Driver datasheet.

3.3.3 Fault Monitoring
The fault monitor section at the right side of the screen allows the user to monitor the fault. The LED
staying green indicates ‘No Fault’. When the LED turns red, it indicates that a fault has occurred.

3.3.4 Use the Side-Bar Menu
Use the side-bar menu in the left pane to navigate to the different pages at any time. Click on the
hamburger button in the top-left corner of the GUI to expand the side-bar menu. The following pages that
are displayed in the side-bar menu:
• Home
• Stepper motor control

3.3.5 Menu Bar Options
The following menus are available in the menu bar displayed at the top of the GUI as shown in Figure 10.

http://www.ti.com
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GUI Application www.ti.com

10 SLOU517A–May 2019–Revised May 2020
Submit Documentation Feedback

Copyright © 2019–2020, Texas Instruments Incorporated

DRV84xxEVM GUI User's Guide

Figure 10. DRV84xx EVM GUI (Menu Bar – Help Option)

3.3.5.1 File Menu
The File Menu has the following options:

Program Device—The user can load the firmware (.out) file onto the device by clicking this option. For
the firmware load to work, MSP430 FET needs to be plugged into the J2 connector on the EVM
board.

Load/Save Registers —The user can save (and load) a particular configuration of the registers. This
saves time when the user needs to reconfigure the registers after power cycle.

3.3.5.2 Options Menu
This menu provides the option to configure the serial port communication settings.

3.3.5.3 Help Menu
The Help Menu contains options to view Readme File and About Section. The About Section displays the
installed software information, including the application version.

http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLOU517A
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